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Seminer Konularõ 

GENEL MODELLEME TEKNİKLERİ 

• Programõn Nesne Tabanlõ Olmasõnõn Avantajlarõ 

• Model Oluşturma ve Düzenleme, Koordinatlar, Gridler ve Kenetleme Seçenekleri 

• Kõsayollar ve Üretkenliği Arttõran Seçenekler 

• Hõzlõ Çizim, Çoğaltma, Dönüştürme, Taşõma, Kõrpma, Hizalama, Ortalama, Ofset ve 
Bölümlendirme  

• Perspektif Görünüşler, Çoklu Kesit İzleri, Referans Düzlemleri ve Referans Çizgileri 

• AutoCAD ile Dosya Aktarma/Alma Seçenekleri 

STATİK VE DİNAMİK YÜKLER ALTINDA DİYAFRAMLAR 

• Statik Yöntem 

• Davranõş Spektrumu 

• Zaman Alanõ 

• Özel Sismik Yük Etkileri 

• Nonlineer ve Statik İtme Analizi (pushover) 

• Rijit, Yarõ Rijit ve Esnek Kat Diyaframlarõ 

ÇELİK ÇERÇEVE BOYUTLANDIRMASI 

• Eleman Boyutlarõ Önceden Seçilmeden Çelik Çerçeve Boyutlandõrma  

• Eleman boyutlarõ için ikinci bir tahmine gerek olmadan Otomatik Virtüel İş ile Yatay 
Öteleme Kontrolü 

• ETABS ile detaylõ Eş Merkezli Çapraz Boyutlandõrma ve elle yapõlan hesaplarla 
karşõlaştõrma 

• Dõş Merkezli Çapraz detaylõ üzerine tartõşma 

• Tam bağlanmamõş Çapraz Dizaynõ (Unbonded Brace Design) 

• Moment Çerçevesi Boyutlama 

• Kompozit Kiriş Boyutlama 

• Titreşim Analizi 
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Giriş 
Buradaki alõştõrmalar ETABS programõnõ orta seviyede bilen kullanõcõlara yöneliktir. Buna 
rağmen, daha önce hiç ETABS kullanmadõysanõz bile bu alõştõrmalarõ yapabilirsiniz. Bu 
alõştõrmalar deneyimsiz bir ETABS kullanõcõsõnõn bile rahatlõkla takip edebileceği şekilde 
özenle hazõrlanmõştõr. Burada gösterdiğimiz tüm alõştõrmalarda (en baştaki birkaç gerçek yapõ 
modeli haricinde) yukarõda bahsedilen genel ve alõşõlmõş modelleme tekniklerini göstermek 
amacõyla örnekler en baştan çizilecektir.  

Bu alõştõrmalarda genel modelleme teknikleri, statik yüklemeler, çelik çerçeve boyutlandõrma, 
nonlineer zaman alanõ analizi ve statik itme analizleri tartõşõlacaktõr.  

Burada sekiz adet örnek problem tartõşõlacaktõr. Bu seminer notlarõnda tüm örneklerin 
tariflerini, bilgisayar modellerinin tanõmlarõnõ ve sonuçlarõnõ bulacaksõnõz. Modelleri 
istediğiniz sõrayla takip edebilirsiniz. 
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Örnek I 
Genel Modelleme Teknikleri �  
Kõsayollarõ ve Üretkenliği Arttõrõcõ Özellikleri 
Gösteren Örnekler 

Tanõm 

Aşağõda çeşitli önemli modelleme tekniklerini göstermek amacõyla birkaç ETABS modeli 
sunulmuştur. 

İlk örnek, seçilen elamanlarõn �gruplara� atanmasõnõn önemi ve �atamalarõ kopyala� (copy 
assingns) komutunun sağladõğõ yararlar açõklanmaktadõr. Aynõ zamanda döşeme 
elemanlarõnõn modellenmesinde rijit diyafram uygulamasõ Şekil 1-1  ve Şekil 1-2 �de 
gösterilmektedir.  

Giriş niteliğindeki bu ilk bölümde aynõ zamanda ETABS daki �benzer katlar� (similar stories) 
özelliği tartõşõlacaktõr. Karmaşõk geometrisi olan bir bilgisayar modelini yapmak için birden 
fazla grid sisteminin kullanõlmasõ Şekil 1-3 �de gösterilmektedir.  

Şekil 1-4 �de eğik bir diyaframõn kolayca modellenebileceği görülmektedir. Farklõ çatõ 
yükseklikleri olan bir binanõn tanõmlanabilmesi için referans düzlemleri (reference planes) 
eklenmiştir.  

Örnek I-1 �de Gösterilen Önemli ETABS Seçenekleri 

! Atamalarõ Kopyalama 

! Grup Atamalarõ 

! Esnek Diyaframlar 

! Benzer Katlar 

! Microsoft Excel programõna veri aktarõlmasõ 

! Kesit ve Plan Görünüşlerinde dolaşma 

! DXF veya AutoCAD dosyalarõndan veri alõnmasõ 

! Boyutlama Grubu Seçimi Özelliği  

! Çelik Çapraz Boyutlama Kombinezonlarõ 
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Örnek I-1  

Bilgisayar Modeli Tanõmõ 

Şekil 1-1 �de 25 katlõ geometrisik düzensizliği olan bir bina görülmektedir. Yapõnõn üçüncü 
katõnda taban izolatörleri bulunmaktadõr, X-doğrultusunda 14 ve Y-doğrultusunda 15 adet 
grid vardõr. Yapõda aynõ zamanda yatayda ve düşeyde düzensizlikler görülmektedir.  

Model statik ve dinamik yüklere maruzdur. Yapõnõn boyutlandõrmasõnda ağõrlõk yükleri 
(gravity loads) ve yatay zaman alanõ fonksiyonlarõ (lateral time history functions) çeşitli 
kombinezonlarda kullanõlmõştõr.  

  

Şekil 1-1 Yapõnõn 3-D görünüşü 

Tanõm 

Şekil 1-2 �de iç kõsõmdan bir çaprazlõ çerçeve kesit görünüşü gösterilmektedir. Burada bir 
çaprazlõ çerçeve bulunmasõnõn amacõ, yatay yüklerin kayma ve devrilme etkilerine karşõ 
mukavemet sağlamaktõr. Çatõdaki ve orta yükseklikteki yatay kafes elemanlarõ, devrilme 
kuvvetlerini içerideki çaprazlardan alõp yapõnõn dõşõna aktararak bu kuvvetlerin 
paylaştõrõlmasõnõ sağlayan transfer kafesleridir. Yatay kafesin üst ve alt başlõk elemanlarõnõ 
doğru olarak modellemek için düğüm noktalarõnõn rijit kat diyaframõndan bağlantõlarõ 
kesilmelidir. Böylece yatay kefesin başlõk elemanlarõnda uzama ve kõsalma etkilerine izin 
verilmiş olunur.  

Copy Assings (Atamalarõ Kopyala) komutunun kullanõmõnõ göstermek için, tüm bir kolon 
çizgisi kopyalanabilir ve modelin herhangi bir yerine yapõştõrõlabilir. Kesitler, uç 
serbestlikleri, ofsetler, çõktõ alõm bölgeleri, yerel eksenler, özellik düzenleyicileri ve çubuk 
tipleri gibi yapõlan tüm atamalarõn tek bir komutla kopyalanõp bir başka yere atanabileceğine 
dikkat ediniz.  
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Şekil 1-2   İçten çaprazlõ çerçevenin görünüşü 

Örnek I-2 

Örnek I-2 �de Gösterilen Önemli ETABS Seçenekleri 

! Birden Fazla Grid Sistemi kullanõmõ 

! Eleman Yerel Eksenleri 

Bilgisayar Modeli Tanõmõ 

Şekil 1-3 �de iki grid sistemi olan bir yapõ gösterilmektedir.  Birinci grid kartezyen koordinat 
sistemindedir. İkinci grid ise silindirik koordinat sistemindedir.  

  

Şekil 1-3 Çoklu Grid Sistemi olan bir yapõnõn plan görünüşü 
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Örnek I-3 

Örnek I-3 �de Gösterilen Önemli ETABS Seçenekleri 

! Farklõ grid sistemlerinde çatõ elemanlarõ modelleme  

! Eğik Diyaframlar 

! Referans Düzlemleri 

! Referans Çizgileri 

! Çizgi Böl (Divide Lines) / Çizgileri Birleştir (Join Lines) Seçenekleri 

! Noktalarõ Birleştirme 

! Noktalarõ Hizalama 

Bilgisayar Modeli Tanõmõ 

Şekil 1-4 �de birden fazla çatõ diyaframõ olan bir spor salonu yapõsõ görülmektedir. Çatõ 
diyaframlarõnõn bazõlarõ farklõ çatõ seviyelerine yayõlmõştõr ve eğimlidir. Yapõda �çizgileri 
böl� (divide lines) seçeneği kullanõlarak yerleştirilmiş  çeşitli çapraz elemanlarõ vardõr. 
Modelin üretilmesine yardõmcõ olmak amacõyla referans düzlemleri (reference planes) de 
kullanõlmõştõr.  

  

Şekil 1-4 Eğik diyaframlarõ olan bir yapõnõn 3-D resmi 
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Örnek II Genel Modelleme Teknikleri II �  
Dört Katlõ C-Şeklinde Çelik Çerçeve Yapõsõ 

Tanõm 

Bu model üç katlõ ve C-şeklinde bir yapõdõr. Düşey statik yüklere ve 1997 Uniform Building 
Code yönetmeliğine göre bilgisayarla üretilmiş deprem yüklemesine maruzdur. Yapõ, her kat 
seviyesinde betonarme bir kompozit döşeme bulunmak üzere, çelik kolon ve kirişlerden 
oluşmaktadõr. 

Örnekte Gösterilen Önemli ETABS Seçenekleri 

! Hõzlõ Kiriş ve Kolon Çizimi  

! Döşeme alanõ üretilmesi 

! Alanlarõ Büyüt/Küçült (Expand/Shrink Areas) Seçeneği 
! Çelik Boyutlandõrma Optimizasyonu 
! Mod Şekilleri 
! Yatay Deplasman Hedefleri (Lateral Displacement Targets) 
! Yerel Eksen Doğrultularõ  

Bilgisayar Modeli Tanõmõ 

Yapõ C şeklindedir ve herbir açõklõk hizasõnda 4 kolon olmak üzere, 3 açõklõklõ bir sistemdir. 
Tüm açõklõklar 24 feet genişliğindedir. Tüm katlar 12 feet yüksekliğindedir. Kip-inç-saniye 
birimleri kullanõlmõştõr. Elastisite modülü 29000 ksi �dir. Çerçevenin geometrisini görmek 
için lütfen Şekil 1-2 �ye bakõnõz.  

Yapõyla ilgili diğer parametreler aşağõdaki gibidir: 

Sõcaklõk genleşme katsayõsõ = 6.500E-06 
Poisson oranõ = 0.3 
Minimum Akma Gerilmesi Fy = 50 ksi 
Minimum Çekme Dayanõmõ  = 65 ksi 

Kompozit Döşeme Özellikleri: 

Döşeme yüksekliği (slab dept) = 3.25 in 
Kompozit döşeme yüksekliği (dect dept) = 3 in 
Diş Genişliği (rib width)  = 6 in 
Diş Aralõğõ (rib spacing) = 12 in 
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Servis Yükleri: 

Ek Ölü Yük Çatõ = 30 psf 
 Kat 3 = 30 psf 
 Kat 2 = 30 psf 
 Kat 1 = 30 psf 

 

UBC97 sismik yük analizini için, yapõyla ilgili yönetmelik parametreleri aşağõdaki gibidir:  

UBC Sismik bölge çarpanõ, Z = 0.4 
UBC Zemin Tipi = SC 
UBC Önem Katsayõsõ, I = 1.0 
UBC Aşõrõ zorlama çarpanõ = 8.5 
UBC Ct katsayõ = 0.035 
UBC Deprem kaynağõna yakõnlõk 
    çarpanõ, deprem kaynağõ tipi = B 
Kaynağa Uzaklõk = 15 km 

 

Hõzlõ Kiriş ve Kolon Çizimi 

 Bölgede veya Tõklayarak Çubuk Çizilmesi: 

Draw menüsü > Draw Line Objects > Create Lines in Region or at Clicks 
(plan, elev, 3D) (Çiz > Çizgi Nesnesi Çiz > Çubuk Çiz / Bölgede veya 
Tõklayarak) komutu iki şekilde çalõşõr.  

Herhangi bir grid çizgisi üzerine tõklayõnõz (plan görünüşünde). O grid çizgisi 
üzerinde, aynõ koordinat sisteminden onu kesen iki grid çizgisi arasõna, bir çizgisel 
nesne çizilecektir.  

Alternatif olarak, tüm görünüşlerde, farenin sol tuşuna basõn ve basõlõ tutun. Sol 
tuşa basõlõ tutarken, fareyi bir veya daha fazla grid çizgi parçasõnõ içine alacak 
şekilde pencere içine alõn. Daha sonra sol tuşu bõrakõn. Pencere içine alõnan her bir 
grid çizgi parçasõ üzerine otomatik olarak çizgisel nesneler konulacaktõr. Bu 
paragrafta �grid çizgi parçasõ� terimi, aynõ koordinat/grid sistemindeki bir grid 
çizgisinin, onu kesen bitişik iki grid çizgisi arasõnda kalan kõsmõ anlamõnda 
kullanõlmõştõr.  

 Bölgede veya Tõklayarak Kolon Çizilmesi: 

Draw menüsü > Draw Line Objects > Create Columns in Region or at Clicks 
(plan) (Çiz > Çizgi Nesnesi Çiz > Kolon Çiz / Bölgede veya Tõklayarak)  komutu 
aktif hale getirildikten sonra kolonlarõ çizmek için iki yol vardõr: Bunlar;  

Plan görünüşünde herhangi bir yerde sol tuşa tõklayarak kolon çizebilirsiniz (altta 
düşey çizgisel nesne).  

Plan görünüşünde çalõşõrken, farenin sol tuşuna basõnõz ve basõlõ tutunuz. Bölgede 
çubuk çizerken kullandõğõnõz aynõ yöntemi kullanõn. Kolonlar (altta düşey çizgisel 
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nesneler) pencere içine alõnan aynõ koordinat/grid sistemindeki tüm grid 
çizgilerinin kesişimlerine otomatik olarak konulacaktõr.  

Kolonlar (düşey çizgisel nesneler) çizim yaptõğõnõz kat seviyesinden bir alttaki 
katõn seviyesine uzanõr. Eğer ETABS durum çubuğundaki benzer katlar (similar 
stories) seçeneği aktifse diğer kat seviyelerine de çizilecektir.  

 Bölgede veya Tõklayarak Tali Kiriş Çizilmesi: 

Draw menüsü > Draw Line Objects > Create Secondary Beams in Region or 
at Clicks (plan) (Çiz > Çizgi Nesnesi Çiz > Tali Kiriş Çiz / Bölgede veya 
Tõklayarak)  komutu tek bir tõklamayla (tali) kirişlerin tüm bir grid çizgisi alanõna 
(kiriş açõklõğõna) çizilmesini sağlar. Grid çizgisi alanõ kesişen dört bitişik grid 
çizgisiyle tanõmlanõr. Eğer grid çizgisi alanõ içinde daha önceden kiriş varsa, alan 
ve tali kirişlerin uzunluğu grid çizgileri yerine orada önceden bulunan bu kirişlere 
bağlõdõr. Aşağõdaki şekil grid çizgisi alanõ ve tali kirişlerle ilgili bir örnek olarak 
görülebilir. Grid çizgileri arasõnda tali kirişlerin olmadõğõna dikkat ediniz.  

Alan Nesnesi Çizilmesi 

Draw menüsü > Draw Area Objects > Draw Areas (plan, elev, 3D)  (Çiz > Alan Nesnesi 
Çiz > Alan Çiz) komutunu kullanarak bir alan nesnesi çizmek için; alanõn ilk köşe noktasõna 
bir kez sol tõklayõn, fareyi bir sonraki köşe noktasõna taşõyõn ve sol tõklayõn, ve bu şekilde 
devam ederek alan nesnesinin tüm köşe noktalarõnõ tanõmlayõn. Fareyi taşõrken alan 
nesnesinin o anki kapsamõnõn kesikli çizgilerle  gösterildiğine dikkat ediniz.  

Alan nesnesinin son köşe noktasõna ulaştõğõnõzda, nesneyi tamamlamak için çift tõklayõnõz. 
Bunun yerine önce tek bir kez sol tõklayõp daha sonra klavyede Enter tuşuna basabilirsiniz.  

Bu komutla çizilen alan nesnelerinin üç veya daha fazla sayõda köşe noktasõ olabilir.  Genel 
olarak alan nesnelerinin en fazla dört kenarõ olabilir; bununla birlikte, yatay alan nesneleri için 
kenar sayõsõnda bir üst limit yoktur (asal XY düzlemi). 

Bu fonksiyonlarõ kullandõktan sonra C-Şeklindeki modelimiz aşağõdaki gibi görünmelidir:  
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Şekil 2-1 Yapõnõn 3D Görünüşü 

Sonuçlar 

Analiz çalõştõrõldõktan sonra (Analyze menüsü > Run Analysis), Design > Steel Frame 
Design > Start Design/Check of Structure (Boyutlandõrma > Çelik Çerçeve Boyutlandõrma 
> Boyutlandõrma/Tahkiki Başlat) komutuna gidiniz. ETABS size analiz ve boyutlandõrma 
kesitlerinde farklõlõk oluşan 132 çelik çubuk olduğunu söylecektir. Boyutlandõrma iterasyona 
dayalõ bir işlemdir. Genel olarak asõl analizi çalõştõrõrken kullandõğõnõz kesitler boyutlandõrma 
işleminin sonunda elinizde olacak kesitlerle aynõ olmaz. Bina analizinin her zaman sonuç 
çubuk kesitleriyle yapõldõğõna emin olmak isteyeceksiniz ve daha sonra o analizden elde 
edilecek kuvvetlerle tekrar boyutlandõrma tahkikini çalõştõracaksõnõz. Design menüsü  > Steel 
Frame Design > Verify Analysis vs. Design Section (Boyutlandõrma > Çelik Çerçeve 
Boyutlandõrma > Boyutlandõrma Kesitini Analiz Sonuçlarõna göre Kontrol Et) komutunu 
boyutlandõrma kesitlerinin analizde kullanõlan kesitlerle aynõ olduğuna emin olmak için 
kullanabilirsiniz.  
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Analiz ve boyutlandõrma tekrar çalõştõrõldõktan sonra, aşağõdaki Şekil 2-2 �de görüldüğü gibi 
Düğüm Noktasõ 13 �ün deplasmanlarõna bakacağõz.  

 

 

Şekil 2-2 Deprem Yük Durumu altõnda Şekil Değiştirmiş Hal 

Yatay Yer Değiştirme Hedeflerinin Seçimi 

4. Kattaki düğüm noktasõ 13 �ün X-doğrultusundaki deplasmanõnõn 1.21 inç olduğunu 
görebilirsiniz. Eğer bu düğüm noktasõndaki maksimum deplasmanõn .9 inç değerini 
aşmamasõnõ istersek, bunu sağlamak için yatay deplasman hedefi (lateral displacement target) 
tanõmlarõz. Menüden Design > Steel Frame Design > Set Lateral Displacement Targets 
(Boyutlandõrma > Çelik Çerçeve Boyutlandõrma > Yanal Deplasman Hedefleri Seç) 
komutuna tõklayarak çeşitli yük durumlarõ için deplasman hedefleri tanõmlayabileceğiniz 
Displacement Optimization (Deplasman Optimizasyonu) formunu açõnõz. X-
doğrultusundaki yanal deprem yükü için maksimum deplasman değeri olarak .9 inç değerini 
giriniz.  

Buradaki amacõmõz � genellikle yapõmõzõnõn çatõ seviyesinde � bir nokta seçmek ve bir veya 
daha fazla sayõda yük durumu için bir maksimum deplasman hedefi (herhangi bir yönde)  
tanõmlamak. Deplasman optimizasyonu için, ETABS elemanlarõn birim hacmine düşen enerji 
miktarõna dayanarak deplasman hedeflerinin sağlanmasõ için hangi elemanlarõn kesit 
boyutlarõnõn arttõrõlmasõ gerektiğine karar verir. Birim hacmine daha fazla enerji düşen 
elemanlarõn boyutu birim hacmine daha az enerji düşen elemanlara göre daha büyük bir 

D. Noktasõ 
13 
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yüzdeyle arttõrõlõr. Birim hacmine düşük enerji düşen bazõ elemanlarõn boyutlarõ eğer 
dayanõmlarõ istenen seviyeyi karşõlayacaksa küçültülebilir.  

Bundan sonra, analiz ve boyutlandõrmayõ tekrar çalõştõrõn. ETABS size 86 çubuk elemanõn 
analiz ve boyutlandõrma kesitlerinin farklõ olduğunu söyleyecek. Bu 86 çubuk elemanõn 
boyutunun düğüm noktasõ 13 �deki deplasman kontrolünü sağlamak için değiştirildiği 
anlamõndadõr. ETABS daha sonra size bu kesitleri değiştirmek isteyip istemediğinizi 
soracaktõr. Yes (Evet) �e tõklayõn. Sadece X-doğrultusuna paralel elemanlarõn boyutlarõnõn 
büyüdüğünü göreceksiniz. Düğüm Noktasõ 13 �ün deplasmanõ .81 inç �dir. Eğer iterasyonu 
sürdürürseniz, buradaki deplasman istenen .9 inç değerine yaklaşacaktõr.  

  

Şekil 2-3   X-Doğrultusundaki çerçeve elemanlarõ 

Mod Şekilleri (Mode Shapes)  

Display > Show Mode Shape (Görüntüle > Mod Şekilini Göster) komutuna tõklayarak Mode 
Shapes (Mod Şekilleri) formunu görüntüleyiniz. Şekil değiştirmiş halini çizmek istediğiniz 
modu seçiniz. Bu yapõ esnek diyafram (flexible diaphragm) olarak modellendi. Bu durum 
modelin kendi düzlemine (asal Z-ekseni) dik bir eksen etradõnda dönmeyeceği, rijit cisim gibi 
davranacağõ anlamõna gelir.  

D. Noktasõ 
13 



www.comp-engineering.com/havuz.html  Computers & Engineering 

ETABS ile Çelik Yapõlarõn Optimize Edilerek Modellenmesi ve Boyutlandõrõlmasõ   16 

 

Şekil 2-4   C- Şekilli yapõ � Mod Şekli 11 
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Örnek III Gelişmiş Modelleme Teknikleri �  
Sekiz Katlõ Otopark Yapõsõ 

Tanõm 

Bu yapõ, her kat seviyesinde eğrisel rampalar bulunan sekiz katlõ bir otopark binasõdõr. Kat 
yükseklikleri 12 feet �dir. X-doğrultusundaki tüm açõklõklar 24 feet, Y-doğrultusundaki 
açõklõklar da 36 feet genişliğindedir. Yapõ rampalarõn kenarõnda bulunan eğrisel bir perde 
duvar sistemiyle yatay olarak mesnetlenmiştir.  

Örnekte Gösterilen Önemli ETABS seçenekleri 

! Çoğaltma Seçenekleri 

! Çizgilerden Alan Üretilmesi Özelliği 

! Rampa Üretilmesi 

! Eğrisel Perde Duvar Üretilmesi 

! Çoklu Kesit İzlerinin Çizilmesi 

! Otomatik Çizgi Bağõmlõlõğõ Özelliği 

! OpenGL Görünüşlerinin Üretilmesi 

! Otomatik Ağõrlõk Yükleri, Otomatik Yanal ve Sismik Yükler 

! Rijit, Yarõ Rijit ve Esnek Döşeme Diyaframlarõ 

! Hareketli Yük Azaltma Çarpanlarõ 

! Betonarme Döşeme Diyafram Seviyesinde Kesme Kuvvetleri ve Çoklu Kesitler 

! Eleman Özellik Düzeltme Çarpanlarõ 

! Başlõk ve Toplayõcõ Kuvvetleri  

! Perde Duvar ve Döşemeler için Bölümlendirme Teknikleri 
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Bilgisayar Modeli Tanõmõ 

Grid ve Çizgilerin Üretilmesi 

Yapõ her bir açõklõkta hizasõnda 11 kolon olmak üzere, 5 açõklõklõ bir sistemdir. Kip-inç-saniye 
birimleri kullanõlmõştõr. X ve Y doğrultularõndaki açõklõklar sõrasõyla 24 ve 36 feet �dir. Yapõ 8 
katlõdõr ve kat yükseklikleri 12 feet �dir.  

Bu modeli üretmek için, kesit görünüşü 3 �e gidiniz. Grid çizgisi C den Grid çizgisi A ya bir 
çubuk çiziniz. Bu çubuğu seçip Edit > Replicate > Story Tab (Düzenle > Çoğalt > Kat 
Sekmesi) komutuna gidiniz ve ÇİFT katlarõ seçiniz (katlarõ seçerken CTRL tuşuna basõlõ 
tutarak).  Grid çizgisi I �dan Grid çizgisi K �ya bir çubuk çiziniz ve bu kez bu çubuğu 
çoğaltõrken TEK tek katlarõ seçiniz. Daha sonra, 8. kattan 7. kata çaprazlamasõna çubuk 
çizerek başlayõp, her kattaki çubuklarõ çaprazlarla birleştirin. (Bu örnekte, seçtiğiniz kiriş 
boyutunun bir önemi yoktur). Model aşağõdaki gibi görünmelidir.  

  

Şekil 3-1  Rampa Yapõsõnõn Kesiti 

Rampa Üretilmesi 

Bundan sonra, her kattaki tüm yatay kirişleri ve tüm diğer eğik kirişleri seçiniz. Edit > 
Extrude Lines to Areas > Linear (Düzenle > Çizgilerden Alan Oluştur > Doğrusal) 
komutuna gidiniz. Increment Data (Artõş Bilgisi) kutusunda dy için 36 feet ve çoğaltma 
adedi (number) için de 2 yazõnõz. Sonra da, tüm düz kirişleri tekrar ve ilk seferde seçili 
olmayan tüm eğik kirişleri seçiniz  Aynõ dönüştürme uygulamasõnõ tekrar yapõn fakat bu kez 
dy için -36 ft kullanõn. Modeliniz şimdi Şekil 3-2 �deki gibi görünmeli.  
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Şekil 3-2  Rampa Yapõsõnõn 3-D Görünüşü 

Dairesel Kenar Rampasõ Üretilmesi 

Artõk, dairesel rampayõ yapmaya hazõrõz. A kesit görünüşüne gidiniz, ve Grid çizgisi 3 ve 4 
arasõndaki bir noktadan Grid çizgisi 5 �e bir çubuk çiziniz. (Draw > Snap to > Line and 
Edges altõnda çizgi ve kenarlara kenetle seçeneklerinin aktif olduğuna emin olunuz). Bu 
çubuğu tüm çift katlara çoğaltõnõz. A Kesitindeki tüm çubuklarõ seçiniz ve Edit > Extrude 
Lines to Areas > Radial  (Düzenle > Çizgilerden Alan Oluştur > Radyal)  sekmesine gidiniz. 
Rampa tam bir yarõm daire olacak bu nedenle, değerleri 10 derece açõyla 18 kere 
döndürülerek toplam 180 derecelik eğri bir yüzey olmasõnõ sağlayacak şekilde giriniz. Toplam 
düşüş 2 kat yani 288 inç olacaktõr. (Angle: 10, Number: 18 ve Total Drop: 288 in) 
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Şekil 4-3  Extrude Lines to Areas (Çizgilerden Alan Oluştur) formu 

Bu adõmõ tamamladõktan sonra, modeliniz Şekil 3-4 �deki gibi görünmeli.  

 

 

Şekil 3-4  Dairesel Rampa Yapõsõ 

Eğrisel Perde Duvar Üretilmesi 

Burada dairesel rampa yüzeyinin kenarõnda, yapõnõn tüm yüksekliği boyunca uzanacak eğrisel 
bir perde duvar yüzeyi üretmekle ilgileneceğiz. Kat planõ 8 �e gidin ve ekranõn sağ 
kenarõndaki aşağõ açõlõr kutudan All Stories (Tüm Katlar) seçeneğini seçiniz. View > Set 
Building View Options (Görünüş > Bina Görünüş Seçeneklerini Değiştir) formunda Point 
Objects (Noktasal Nesneler) seçeneği altõndaki invisible (gizli) anahtarõnõ seçili durumdan 

Rampa grid çizgisi 3 ve A 
etrafõnda döndürüldü. Y 
koordinatõ 864 tür. 
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çõkarõnõz. Bu seçenek kullanõcõnõn eğrisel perde duvarõ oluştururken düğüm noktalarõnõ 
görmesini ve onlara kenetlenmeyi sağlayacaktõr. Draw > Draw Area Objects > Draw Walls 
(Çiz > Alan Nesnesi Çiz > Duvar Çiz) komutuna gidiniz ve Grid çizgileri A ve 5 in 
kesişiminde bulunan düğüm noktasõ üzerine tõklayõnõz. Rampanõn kenarõ etrafõndaki tüm 
düğüm noktalarõna tõklamaya devam ediniz. Yarõm dairenin yarõsõna geldiğinizde, kat planõ 7 
�ye gitmeniz gerekli çünkü Kat 8 altõnda bulunan diğer düğüm noktalarõ görülmeyecektir. 
Grid çizgileri 1 ve A �nõn kesişimine geldiğinizde yarõm daire tamamlanacaktõr.  

Developed Elevation (Çoklu Kesit İzi) 

Çoklu kesit izleri yapõnõn birden fazla yüzünü tek bir açõlmõş görünüş içinde aynõ anda 
gösterebilirler. Bir çoklu kesit izi çizmek için önce, menüden Draw > Draw Developed 
Elevation Definition (Çiz > Çoklu Kesit İzini Çizerek Belirt) seçip, formun Developed 
Elevations (Çoklu Kesit İzleri) alanõndaki derleme kutusuna çoklu kesit izi için bir isim 
yazõp, Add New Name (Yeni İsim Ekle)  kutusuna tõklanmalõdõr. Daha sonra, kat planõ 8 de, 
eğrisel perde duvarõn çiziminde yapõldõğõ gibi, rampanõn kenarlarõndaki düğüm nokalarõ 
üzerine tekrar bir yarõm daire tamamlanõncaya kadar tõklayõp kesit çizilmelidir. Kesiti View 
menüsü > Set Elevation View (Görünüş > Yandan Görünüş Seç) seçeneğine tõklayõp,  
oluşturduğunuz çoklu kesit izinin ismini seçerek görebilirsiniz.  

Not: Eğer Options menüsü > Windows (Seçenekler > Pencereler) komutu iki veye daha 
fazla pencere için ayarlandõysa ve bu pencereler Plan veya 3D Görünüşe ayarlõysa, çoklu kesit 
izi bu Plan ve 3D Görünüş pencerelerinde cyan renginde bir çizgiyle (ön tanõmlõ) 
gösterilecektir. Bir kaç duvar elemanõnõ seçerek onlarõ siliniz. Bu eğri perde duvar elemanõ 
üzerinde bir açõklõk oluşturacaktõr. Modeliniz Şekil 3-5 �deki gibi görünmelidir.  

 

 

Şekil 3-5  Eğrisel Perde Duvarlarõ olan Dairesel Rampa Yapõsõ 



www.comp-engineering.com/havuz.html  Computers & Engineering 

ETABS ile Çelik Yapõlarõn Optimize Edilerek Modellenmesi ve Boyutlandõrõlmasõ   22 

Otomatik Çizgi Bağõmlõlõğõ (Auto Line Constraint)  

Eğer Şekil 3-5 �e dikkatlice bakarsanõz, perde duvar ve rampa düğüm noktalarõnõn ortak 
olmadõğõnõ görürsünüz. Genel olarak sonlu eleman analizinde kabuk elemanlar diğer 
elemanlara sadece köşe noktalarõnda birleştirilir. Bir eleman eğer kabuk elemanõn köşe 
noktasõna bağlanmõyor,  bunun yerine kabuk elemanõn kenarõna geliyorsa, bu elemanla kabuk 
eleman arasõnda bir bağlantõ oluşmaz. Bununla birikte ETABS otomatik çizgi bağõmlõlõğõ 
(auto line constraint) özelliğini kullanõr. ETABS �õn otomatik çizgi bağõmlõlõğõ özelliği bir 
elemanõn kabuk elemanõnõn kenarõna bağlanmasõna olanak sağlar. ETABS kendi içinde kabuk 
elemanõn kenarõ boyunca bağõmlõlõk noktalarõ koyarak buna karşõlõk gelen diğer elemanlarla 
birlikte hareketine olanak verir ve elamanlar arasõndaki bağlantõyõ sağlar. ETABS �õn 
otomatik çizgi bağõmlõlõğõ özelliği hakkõnda daha fazla bilgi için Sonlu Eleman Hasõr 
Gruplarõnõn Birleşiminde SAP2000 ve ETABS 'õn Sağladõğõ Kolaylõk başlõklõ makaleye 
bakõnõz. (http://www.comp-engineering.com/downloads/ technical_papers/SAP2000/Line-
Constraints-tr.pdf)  
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Örnek IV Eş Merkezli, Çaprazlõ   
4 Katlõ Çelik Çerçeve Yapõsõ 

Tanõm 

Bu yapõ, dört katlõ eş merkezli (konsantrik) olarak çaprazlanmõş çerçeve yapõsõdõr. Statik 
düşey yüklere ve 1997 Uniform Building Code yönetmeliğine göre bilgisayar  tarafõndan 
üretilmiş deprem yüklerine karşõ koymaktadõr. Yanal yüklere karşõ koymak için bazõ 
açõklõklara X çaprazlarõ konulmuştur. Her katta farklõ doğrultuda iki kompozit döşeme vardõr.  

Örnekte Gösterilen Önemli ETABS seçenekleri 

! Rijit Diyafram Atamalarõ 

! Çoklu Kesitlerin (Section Cuts) kullanõmõ 

! Kabuk elemanlarõn eksenlerinin döndürülmesi 

! Kopyalama (replication) teknikleri  

! Kompozit döşeme elemanõ seçenekleri 

! Hõzlõ çapraz çizimi 

! Otomatik deprem yükleri 

Bilgisayar Modeli Tanõmõ 

Yapõ L şeklindedir ve 12 açõklõklõ bir sistemdir. Her bir açõklõğõ üzerinde 13 kolon vardõr. Kip-
inç saniye birimleri kullanõlmaktadõr. Elastisite modülü 29000 ksi �dir. Çerçeve geometrisini 
görmek için lütfen Şekil 4-1 ve 4.2 �ye bakõnõz.  

Kompozit Döşeme Özellikleri: 

Döşeme Kalõnlõğõ = 3.25 in 
Kompozit Döşeme Kalõnlõğõ = 12 in 
Diş Genişliği (Rib Width) = 6 in 
Diş Aralõğõ (Rib Spacing) = 12 in 

Servis Yükleri: 

Hareketli Yükler Çatõ = 20 psf 
 Kat 3 = 80 psf 
 Kat 2 = 80 psf 
 Kat 1 = 80 psf 
Ek Ölü Yük Çatõ = 73.7 psf 
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 Kat 3 = 75.4 psf 
 Kat 2 = 75.4 psf 
 Kat 1 = 75.4 psf 

 

Bu modelde ölü yük için zati ağõrlõk çarpanõ (self weight multiplier) sõfõr alõnacaktõr. Bu 
değer Define > Static Load Case (Tanõmla > Statik Yük Durumu) altõnda bulunabilir. Bu 
örnekte sadece yukarõda listelenen ek ölü yükler kullanõlacaktõr.  

UBC97 sismik yük analizine göre, yapõyla ilgili yönetmelik parametreleri aşağõdaki 
gibidir:  

UBC Sismik bölge çarpanõ, Z = 0.4 
UBC Zemin Tipi = SC 
UBC Önem Katsayõsõ, I = 1.0 
UBC Aşõrõ zorlama çarpanõ = 8.5 
UBC C1 katsayõ = 0.035 
UBC Deprem kaynağõna yakõnlõk 
    çarpanõ, deprem kaynağõ tipi = B 
Kaynağa Uzaklõk = 15 km 
 

 

 

Şekil 4-1 Yapõnõn 3D görünüşü 



www.comp-engineering.com/havuz.html  Computers & Engineering 

ETABS ile Çelik Yapõlarõn Optimize Edilerek Modellenmesi ve Boyutlandõrõlmasõ   25 

 

Şekil 4-2  Kesit Görünüşü M 

Rijit Diyafram Atamasõ (Rigid Diaphragm Assignment)  

Rijit diyaframlar sadece yatay olabilir. Bu nedenle rijit diyafram atamalarõ duvar-tipi veya 
rampa-tipi alan nesnelerine uygulanamaz. Sadece döşeme tipi veya yatay düzlemde olan  null 
tipi alan nesnelerine uygulanabilir. ETABS �da, bir rijit diyafram  sadece kendi düzlemi içinde 
ötelenir (asal X-Y düzlemi) ve yine sadece kendi düzlemine dik eksen etrafõnda bir rijit cisim 
gibi döner (asal Z ekseni).  Bir alan nesnesine rijit diyafram atamak onun düzlem-dõşõ 
davranõşõnõ değiştirmez. Örneğin, eğer plak-eğilme özellikleri (örneğin, düzlem-dõşõ eğilme 
özelliği) olan bir betonarme kat döşemesi tanõmlarsanõz, bu döşemeye bir rijit diyafram 
bağõmlõlõğõ atanmasõ onun düzlem-dõşõ eğilmesine bir etkisi olmaz. ETABS �da, bir alan 
nesnesine rijit diyafram atanmasõ alan nesnesinin tüm köşe noktalarõna ve o alan nesnesinin 
sõnõrlarõ içinde kalan tüm ek noktasal nesnelere bir diyafram bağõmlõlõğõ atanmasõnõ sağlar. 
Bunlara alan nesnesinin ETABS tarafõndan otomatik bölümlendirilmesi sõrasõnda üretilen tüm 
düğüm noktalarõ da dahildir.  

Sonuçlar 

Çoklu Kesit Kuvvetleri (Section Cut Forces) 

Çoklu Kesitleri (Section Cuts) tanõmlamak için iki seçenek vardõr: 

1. Birinci seçenek; kesitin yerini tanõmlamaktõr. Define menüsü > Section Cuts 
(Tanõmla > Çoklu Kesitler) komutu kullanõlarak bir modelde çoklu kesitete oluşan sonuç 
kuvvetleri bulunabilir. Çoklu kesitler analizden önce veya sonra tanõmlanabilir. Ancak 
tanõmlama için analizin çalõştõrõlmasõnõ beklemek en güvenlisidir. Genel olarak modelin 
tüm  bölümlendirmesi yapõlana kadar (eğer varsa), çoklu kesitlerin tanõmlanmamasõ, daha 
da önemlisi, çoklu kesitlerde kullanõlan gruplarõn tanõmlanmamasõ gerekir. Eğer gruplar  
bölümlendirmeden önce tanõmlandõysa, gruba dahil olmasõ gereken bazõ noktasal nesneler 
henüz oluşturulmamõş olabilir.  
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2. İkinci seçenek; çoklu kesiti modelin herhangi bir kõsmõnda elle çizmektir. Draw > 
Draw Section Cut (Çiz > Çoklu Kesit Çiz) seçeneği kullanõlarak yapõlabilir. Model 
analiz edilmiş olmalõdõr ve bir kuvvet/gerilme diyagramõ görünüşünde olunmalõdõr. Buna 
Display > Show Member Force/Stress Diagram (Görüntüle > Eleman Kuvvet/Gerilme 
Diyagramõnõ Göster) altõnda bir çubuk veya kabuk kuvveti seçerek ulaşõlabilir. Bu örnekte 
çoklu kesit kuvvetlerini bulmak için bu ikinci seçenek kullanõlmõştõr.  

Kat 4 �de Grid çizgisi L ve M arasõnda kabuk gerilme kuvvetlerini bulmak için, Draw > 
Draw Section Cut (Çiz > Çoklu Kesit Çiz) komutuna gidiniz. Grid çizgisi M �e paralel bir 
çizgi çiziniz. Yanõp sönen çizgi Grid çizgisi M boyunca uzanan çoklu kesiti temsil eder. 
Çoklu kesit kuvvetleri ekranda görülecektir. Şekil 4-3 ve 4-3 �e bakõnõz.  

 

Şekil 4-3  Deprem yük durumu için S12 Gerilme Diyagramõ 

Şekil 4-3 �de grid çizgileri 4 ve 6 arasõnda, grid çizgisi M üzerinde yüksek gerilme yõğõlmasõ  
görülmektedir. Burasõ eş merkezli çapraz çerçevelerin bulunduğu yerdir. Gerilme 
diyagramõndan grid çizgisi A üzerinde de çaprazlarõn olduğunu görebilirsiniz.  
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Şekil 4-4  Çoklu kesit kuvvet çõktõsõ 
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Örnek V İki Katlõ Çelik Çaprazlõ Çerçeve Yapõsõ �  
Düşey ve Yatay Yük Analizi 

Tanõm 

Bu örnekte iki katlõ bir çelik çaprazlõ çerçeve yapõsõ düşey statik yüklere ve verileri 
programda mevcut olan  1997 Uniform Building Code yönetmeliğine göre bilgisayar  
tarafõndan üretilmiş deprem yüklerine karşõ koymaktadõr. Yanal yükler, betonarme perde 
duvarlar ve çelik çaprazlarla karşõlanmaktadõr. Yapõnõn çatõ katõnda ağõr mekanik ekipman 
yükleri vardõr.  

Çerçevenin geometrisini Şekil 5-1 ve Şekil 5-2 �de görülmektedir.  

Örnekte Gösterilen Önemli ETABS seçenekleri 

! Otomatik Deprem ve Rüzgar Yükü Üretilmesi 

! Kabuk Eleman Seçenekleri 

! Null tipi kat elemanlarõnõn kullanõlmasõ 

! Kat ve Grid�lerin Düzenlenmesi 

! Kütle Kaynağõ (Mass Source) Seçenekleri 

! Çelik Çapraz Düzeltme Seçenekleri 

! Perde Duvar Üretilmesi 

! Hõzlõ Çapraz Çizilmesi 

! Çelik Çapraz Boyutlandõrmasõ 

! Kompozit Kiriş Boyutlandõrmasõ 

Bilgisayar Modeli Tanõmõ 

Yapõ 3 açõklõklõ bir sistemdir ve her bir açõklõk üzerinde 4 kolon vardõr. Kip-inç saniye 
birimleri kullanõlmaktadõr. Elastisite modülü 29000 ksi �dir.  

Yapõyla ilgili diğer parametreler aşağõdaki gibidir: 

Sõcaklõk Genleşme Katsayõsõ = 6.500E-06 
Poisson oranõ = 0.3 
Minimum Akma Gerilmesi, Fy = 50 ksi  
Minimum Çekme Dayanõmõ, Fu = 65 ksi 

Kompozit Döşeme Özellikleri: 
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Döşeme  Kalõnlõğõ = 3.5 in 
Kompozit Döşeme Kalõnlõğõ = 3 in 
Diş Genişliği = 6 in 
Diş Aralõğõ = 12 in 

Servis Yükleri: 

Hareketli Yükler Çatõ = 20 psf 
 Kat 1 = 125 psf 

 Kompozit  
   Döşeme = 100 psf 

 
Ek Ölü Yük Çatõ = 30 psf 
 Kat 1 = 31 psf 
 Mekanik  
  yükler  = 188 psf 
 

UBC97 sismik yük analizine göre, yapõyla ilgili yönetmelik parametreleri aşağõdaki 
gibidir:  

UBC Sismik bölge çarpanõ, Z = 0.40 
UBC Zemin Tipi = SD 
UBC Önem Katsayõsõ, I = 1.0 
UBC Aşõrõ zorlama çarpanõ = 5.5 
UBC Ct katsayõ = 0.035 
UBC Deprem kaynağõna yakõnlõk 
    çarpanõ, deprem kaynağõ tipi = B 
Kaynağa Uzaklõk = 10 km 
 

 

Şekil 5-1 Yapõnõn 3D Görünüşü 
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Şekil 5-2   1.Kat Planõ Görünüşü 

 

Kütle Kaynağõ (Mass Source) Seçeneği  

ETABS �da, kullanõcõnõn bir yapõdaki kütle dağõlõmõnõ tanõmlarken üç seçeneği vardõr. Define 
menüsü > Mass Source (Tanõmla > Kütle Kaynağõ) komutuna tõklayarak Define Mass 
Source (Kütle Kaynağõ Tanõmla) formunu görüntüleyin. Formda aşağõdaki seçenekleri 
göreceksiniz: 

1. From Self and Specified Mass (Kendi ve Tanõmlanmõş Kütlelerden) :   

Tüm yapõsal elemanlarõn kendileriyle ilişkili malzeme özellikleri vardõr. Malzeme 
özelliklerinde tanõmlanan değerlerden biri de birim hacim kütlesidir (mass per 
unit volume) . From Self and Specified Mass seçeneği işaretlendiğinde, ETABS 
yapõnõn kütlesini ilişkili elemanlarõn kütlesinden bulur. Elemanlarõn kütlesini de 
her bir yapõsal elemanõn hacmini o elemanõn birim hacim ağõrlõğõyla çarparak 
bulur. Bu davranõş ETABS �õn ön tanõmlõ değeridir. Aynõ zamanda bölme 
duvarlar, cephe kaplama elemanlarõ vb. yapõ elemanlarõnõ da dikkate almak için ek 
kütle atanmasõ mümkündür. ETABS herhangi bir ek kütle atamasõnõ elemanõn 
kütlesine ekler ve böylece toplam kütleyi elde eder. ETABS �da kütleler negatif 
değer almazlar.  
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2. From Loads (Yüklerden): 

Bu seçenekte, mevcut yüklerden hareketle yapõnõn kütlesini belirleyen bir yük 
kombinezonu tanõmlanõr. Kütle, yük kombinezonunun yerçekimi ivmesi g �ye 
bölümüyle hesaplanan ağõrlõğa eşittir. Buradan elde edilen kütle, her üç öteleme 
doğrultusundaki etki alanlarõ (tributary area) esas alõnarak düğüm noktalarõna 
aktarõlõr.  

3. From Self and Specified Mass and Loads (Kendi, Tanõmlanmõş Kütle ve 
Yüklerden) : 

Bu seçenek ilk iki seçeneğin birleşimidir. Zati-ağõrlõğõ, tanõmlõ ek kütleleri ve 
yüklerden üretilen kütleleri aynõ analizde kullanmanõza olanak verir.  

From Self and Specified Mass and Loads (Kendi, Tanõmlanmõş Kütle ve Yüklerden) 
seçeneği kullanõlõrken Define Mass Multiplier for Loads (Yükler için Kütle Çarpanõ 
Tanõmla) kutusuna ölü yük durumunun eklenmemesi gerektiğine dikkat edilmelidir. 
Aksi durumda yapõdaki ölü yük iki kere dikkate alõnmõş olur. 
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Sonuçlar 

Taban Kesmesi Hesaplarõ 

Takibeden satõrlardaki veriler File menüsü > Print Tables > Input > Auto Seismic Loads 
(Dosya > Tablolarõ Yazdõr > Veriler > Otomatik Sismik Yükler)  komutu kullanõlarak 
yazdõrõlabilir.  

AUTO SEISMIC INPUT DATA 

Direction:X 
Typical Eccentricity=5% 
Eccentricity Overrides: No 

Period Calculation: Program Calculated (Program tarafõndan hesaplanacak) 
Ct = 0.035 (in feet units) 

Top Story: STORY2 
Bottom Story: BASE 

V = (Cv I W) / (R T)  (Eqn. 1) 
V <= 2.5 Ca I W / R  (Eqn. 2) 
V >= 0.11 Ca I W  (Eqn. 3) 
V >= 0.8 Z Nv I W /R,   (Eqn. 4) 

If  T <= 0.7 sec then Ft = 0 
If  T > 0.7 sec, then Ft = 0.07 T V <= 0.25 V 

AUTO SEISMIC CALCULATION RESULTS 

Ta = 0.4620 sec 
T Used = 0.1865 sec 
W Used = 3910.77 

V (Eqn 1) = 0.8446W 
V (Eqn 2) = 0.2031W 
V (Eqn 3) = 0.0581W 
V (Eqn 4) = 0.0788W 

V Used = 0.2031     W=794.19 Kips 
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Çelik Çerçeve Boyutlandõrmasõ (Steel Frame Design)  

Çelik Çerçeve Boyutlandõrmasõ çalõştõrõldõktan sonra, (Şekil 5-3 �e bakõnõz) kullanõcõ herhangi 
bir çelik çerçeve elemanõna farenin sağ tuşuyla tõklayarak Çelik Gerilme Kontrolü Bilgisi 
(Steel Stress Check Information) formunu görüntüleyebilir. Burada Details (Detaylar) 
komutuna tõklayarak, seçilen boyutlandõrma kombinezonu ve çõktõ alõm bölgesi (station 
location) için detaylõ boyutlandõrma bilgileri görüntülenir. (Şekil 5-4 �e bakõnõz.) 

 

Şekil 5-3  E Kesiti Görünüşü 

 

Şekil 5-4  Çelik Gerilme Kontrolü Detay Çõktõlarõ 
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Kompozit Kiriş Boyutlandõrmasõ (Composite Beam Design)  

Kompozit Kiriş Boyutlandõrmasõ çalõştõrõldõktan sonra, sonuçlar iki farklõ yöntem kullanõlarak 
görülebilir: 

1. Metin Formatõ: File > Print Tables > Composite Beam Design (Dosya > Tablolarõ 
Yazdõr > Kompozit Kiriş Boyutlandõrmasõ)  

2. Grafik üzerinde: Design > Composite Beam Design > Display Design Info 
(Boyutlandõrma > Kompozit Kiriş Boyulandõrma > Boyutlandõrma Bilgilerini Göster) 

Kompozit kiriş boyutlandõrma sonuçlarõnõn grafik üzerinde nasõl görüldüğüne bir örnek olarak 
aşağõdaki Şekil 5-5 verilmiştir. Kompozit döşeme ve mekanik yüklerinin grid çizgisi D ve E 
arasõnda atanmasõndan dolayõ seçilen kiriş boyularõnõn o bölgede daha büyük olduğunu 
görebilirsiniz. Kompozit kirişlerin boyutlandõrõlmasõyla ilgili daha geniş bir açõlama 6. 
örnekte bulunabilir.   

 

 

Şekil 5-5  Kompozit Boyutlandõrma Sonuçlarõ Çõktõsõ 
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Örnek VI Kompozit Kiriş Boyutlandõrmasõ 

Tanõm 

Kompozit Kiriş Boyulandõrmasõ (Composite Beam Design) ETABS �õn önemli özelliklerinden 
biridir. Bu bölümde, iki ayrõ kompozit kiriş örneğini tartõşacağõz. İlk modelde AISC LRFD 
99 yönetmeliği, ikinci modelde ise AISC-ASD 89 yönetmeliği kullanõlacaktõr.  

Örnekte Gösterilen Önemli ETABS seçenekleri 

! Kompozit Döşeme Özellikleri 

! Kompozit Kiriş Özellikleri 

! Aşamalõ İnşaat Yüklemesi (Construction Loading) 
! Saplama (stud) aralõklarõ seçenekleri 

! Kõsmi Kompozit Limitler (Partial Composite Limits) 
! Titreşim Etkisi (vibration)  

Örnek VI-1 

Bu örnekte LRFD 99 yönetmeliği kullanõlarak kompozit kiriş eğilme elemanõ 
boyutlandõrmasõ yapõlacaktõr. Bu model AISC-LRFD 99 �un 3. baskõsõndaki 5.6 örneğinde 
bulunmaktadõr. Model tek katlõ, ölü ve hareketli yüklere maruz 3 boyutlu bir çelik çerçeve 
yapõsõdõr. Bu modelin kalõp sõrasõnda alttan desteklenmemiş ve desteklenmiş hallerini 
inceleyeceğiz. 

  

Şekil 6-1  Yapõnõn 3D Görünüşü 
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Bilgisayar Modeli Tanõmõ 

Kiriş uzunluklarõ 40 feet ve kirişler aralarõndaki mesafe 10 feet�tir. Elastisite modülü 29000 
ksi �dir. Çerçeve geometrisini görmek için Şekil 6-1 �e bakõnõz.  

Yapõyla ilgili diğer parametreler aşağõdaki gibidir: 

Sõcaklõk Genleşme Katsayõsõ = 6.500E-06 
Poisson oranõ = 0.3 
Minimum Akma Gerilmesi, Fy = 50 ksi  
Minimum Çekme Dayanõmõ, Fu = 65 ksi 

Kompozit Döşeme Özellikleri: 

Döşeme Kalõnlõğõ = 3 in 
Kompozit Döşeme Kalõnlõğõ = 3 in  
Diş Genişliği = 6 in 
Diş Aralõğõ = 12 in 

 

 

Servis Yükleri: 

Yük Servis Yükü Yük Çarpanõ 
Yük Katsayõlarõyla 
Arttõrõlmõş Tasarõm 

Yükü 

Ölü .9 k/ft 1.2 1.1 k/ft 

Hareketli 2.5 k/ft 1.6 4.0 k/ft 

Toplam 3.4 k/ft ----- 5.1 k/ft 

Kompozit Kiriş Boyutlandõrma Seçenekleri (Komposite Beam Design Preferences)  

Options menüsü > Preferences > Composite Beam Design (Seçenekler > Tercihler > 
Kompozit Kiriş Boyutlandõrma) komutuna tõklayarak Composite Beam Design Preferenes 
(Kompozit Kiriş Boyutlandõrma Seçenekleri) formunu görüntüleyiniz. Composite Beam 
Design Preferenes formundaki açõlõr liste kutularõna tõklayõp seçerek ya da derleme 
kutularõna yazarak istediğiniz değerleri giriniz. Tercihler menüsü programõn kullanõmõna ve 
görünüşüne, boyutlandõrma son-işlemcisinin geçerli davranõşõna ve programõn hareketli yük 
azaltma çarpanlarõnõ nasõl ele aldõğõna etki eden bir çok seçeneği barõndõrõr. Bu formdaki 
Vibration (Titreşim) sekmesi birinci doğal periyot bulunurken kiriş için alõnan yükün 
hesabõnda, hareketli yük ve azaltõlmõş hareketli yük toplamõnõn dikkate alõnan oranõnõn (ölü 
yüke ek olarak) kullanõcõ tarafõndan belirlenebilmesine olanak verir.  Buna ek olarak ETABS, 
Murray �in minimum sönüm kriterlerini de kiriş kesitinin uygun olup olmadõğõna karar 
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verirken dikkate alõr. Help menüsü > Documentation and Tutorials (Yardõm > Kullanõm ve 
Eğitim Kõlavuzlarõ) komutuna tõklanarak bu formdaki yönetmeliklere özel seçeneklere, 
onlarõn muhtemel değerlerine, onlara atanan ön değerlere ve onlar hakkõnda kõsa bir 
açõklamaya ulaşõlabilir. Bunun için önce Technical Notes � Composite Beam Design 
(Teknik Yazõlar � Kompozit Kiriş Boyutlama) �ya tõklayõn, daha sonra da ilgili yönetmelik 
altõndaki Preferences (Tercihler) üzerine tõklayõnõz.  

Kompozit Kiriş Özellik Düzeltmeleri (Composite Beam Property Overwrites)  

Design menüsü > Composite Beam Design > View/Revise Overwrites (Boyutlandõrma > 
Kompozit Kiriş Boyutlandõrma > Düzeltmeleri Göster/İşle) komutunu kullanarak kompozit 
kiriş üzerinde yapõlan değişiklikleri gözden geçirebilir veya değiştirebilirsiniz. Herhangi bir 
kompozit kiriş düzeltmesi (composite beam overwrite)  atamanõza gerek olmayabilir; ama bu 
seçenek sağlanmõştõr. Eğer boyutlandõrmada takviye levhalarõ (cover plate) kullanõyorsanõz ya 
da kayma kilidi şablonu (user-defined shear connector patterns)   tanõmladõysanõz, onlarõ 
düzeltmeler (overwrites) seçeğini kullanarak atayõnõz. Kompozit kiriş boyutlandõrma 
düzeltmeleri (composite beam property overwrites) sadece özel olarak belirtilmiş kirişlere 
uygulanabilen basit özelliklerdir. Bu nedenle, düzeltmeler (overwrites) tanõmlanmadan önce 
(aynõ zamanda boyutlandõrma ya da herhangi bir kompozit kirişi kontrolünden önce) 
seçeneklerin (preferences) tanõmlanmasõ gerekir.  

Kompozit kiriş düzeltmeleri formundaki sekmelerden biri de Shear Studs (kesme 
saplamalarõdõr) �dõr. Burada bir kullanõcõ-tanõmlõ kayma kilidi şablonunun tanõmlanõp 
tanõmlanmadõğõnõ görebilir, kiriş üzerinde düzgün aralõklarla kesme saplamalarõ (shear studs) 
tanõmlayabilir veya kiriş doğrultusu boyunca kesme saplamalarõnõn (shear studs) minimum ve 
maksimum aralõklarõnõ değiştirebilirsiniz. Şekil 6-2 �de kesme saplamasõ (shear stud)  formu 
görülmektedir.  
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Şekil 6-2  Kompozit Kiriş Düzeltmeleri � Kesme saplamalarõ 

Şekil 6-2 �de görülen Miscellaneous (Çeşitli) sekmesi altõnda, kullanõcõ kiriş için düşünülen 
kompozit bağlantõ yüzdesinin minimum (Minimum PCC) ve maksimum (Maximum PCC) 
değerlerini  ayarlayabilir. Bu örneğin sonuçlar kõsmõnda Minimum ve Maksimum PCC 
değerlerinin nerede hesaplandõğõ gösterilecektir. (Şekil 6-3 �deki #2 �ye bakõnõz.) Vibration 
(Titreşim) sekmesinin altõnda, Neff değerinin kullanõcõ tarafõndan seçilmesini veya seçilen kiriş 
açõklõğõna bağlõ olarak program tarafõndan hesaplanmasõnõ belirleyecek bir seçenek vardõr. 
Burada aynõ zamanda döşemede tahriğe neden olan ayak darbesi etkisinin (heel drop impact)  
�a karşõ koyan  efektif kiriş sayõsõnõ da belirleyebilirsiniz.  

Kompozit Kiriş Boyutlandõrma Kombinezonlarõ 

Design menüsü Composite Beam Design > Select Design Combo (Boyutlandõrma > 
Kompozit Kiriş Boyutlandõrma > Boyutlandõrma Kombinezonu Seç)  komutunu kullanmadan 
önce analizin çalõştõrõlmasõ veya bir elemanõn seçili durumda olmasõ gerekli değildir.  

Design menüsü Composite Beam Design > Select Design Combo (Boyutlandõrma > 
Kompozit Kiriş Boyutlandõrma > Boyutlandõrma Kombinezonu Seç)  komutuna tõklayarak 
Design Load Combinations Selection (Boyutlandõrma Yük Kombinezonlarõ Seçimi) 
formunu açõnõz. ETABS tarafõndan tamõnlanan mevcut kompozit kiriş boyutlandõrma 
kombinezonlarõnõ gözden geçirin veya kendi boyutlandõrma kombinezonlarõnõzõ atayõnõz. 
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Kompozit kiriş boyutlandõrmada; aşamalõ inşaat yüklemesi, dayanõmõn dikkate alõndõğõ son 
yüklemeler ve sehimlerin dikkate alõndõğõ son yüklemeler için ayrõ ayrõ boyutlandõrma yük 
kombinezonlarõnõn tanõmlandõğõna dikkat ediniz. Farklõ tipteki bu boyutlandõrma 
kombinezonlarõ formda ayrõ ayrõ sekmeler altõnda bulunmaktadõr.  

Ön tanõmlõ kompozit kiriş boyutlandõrma kombinezonlarõna DCMPC1 veya buna benzer 
isimler verilir, isimlendirme aşağõdaki gibi yapõlõr;  

• DCMPCn: Burada D boyutlandõrma (design), CMP kompozit (composite) ve son C 
�de inşaat (construction) anlamõndadõr. En sonraki n ise bir sayõdõr. Bu şekilde 
adlandõrõlan boyutlandõrma yük kombinezonlarõ ETABS �õn kompozit 
boyutlandõrmada aşamalõ inşaat yüklemeleri için oluşturduğu ön tanõmlõ 
kombinezonlardõr.  

• DCMPSn: Burada D boyutlandõrma (design), CMP kompozit (composite) ve S �de 
dayanõm (strength) anlamõndadõr. En sonraki n ise bir sayõdõr. Bu şekilde belirtilen 
adlandõrõlan yük kombinezonlarõ ETABS �õn kompozit boyutlandõrmada son yükler 
altõnda dayanõmlarõn göz önüne alõnmasõ için oluşturduğu ön tanõmlõ 
kombinezonlardõr.  

• DCMPDn: Burada D boyutlandõrma (design), CMP kompozit (composite) ve son D 
�de sehim (deflection) anlamõndadõr. En sonraki n ise bir sayõdõr. Bu şekilde belirtilen 
boyutlandõrma yük kombinezonlarõ ETABS �õn kompozit boyutlandõrmada son yükler 
altõnda sehimlerin göz önüne alõnmasõ için oluşturduğu ön tanõmlõ kombinezonlardõr. 

Sonuçlar  

Yük katsayõlarõ ile çarpõlmõş toplam yükler için bulunan gerekli eğilme dayanõmõ: 

2

2

8
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8

2
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8

u
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=

=

=
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Tablo 5-13 �den, Qn = 26.1 k/stud ve gereken kesme saplamasõ (shear stud) miktarõ:  

2 2(810 k)
26.1 k/stud

n

n

Q
Q

= = →∑ 62.1 64 stud  

Analiz ve kompozit kiriş boyutlandõrma çalõştõrõldõktan sonra, bir kiriş elemanõnõn üzerine sağ 
tuşla tõklayarak Interactive Composite Beam Design (Etkileşimli Kompozit Kiriş 
Boyutlandõrmasõ) formunu görüntüleyiniz. Kiriş boyutlandõrmasõnõn bir özetini görmek için 
Details (Detaylar) kutusuna tõklayõnõz. AISC-LRFD örneğinde 64 adet kesme saplamasõ 
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(shear stud) gerektiği hesaplanmõştõ. Eğer Şekil 6-3 �deki Summary (Özet) kõsmõna 
bakarsanõz ETABS tarafõndan 65 adet saplama (stud) gerektiğinin hesaplandõğõnõ 
görebilirsiniz. (Ok #1 �e bakõnõz.) 

 

 

Şekil 6-3  Kompozit Kiriş Boyutlandõrma Detaylarõ 

#1 

#2 
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Örnek VI-2 

Bu örnekte AISC-ASD89 yönetmeliği kullanõlarak kompozit eğilme elemanõ 
boyutlandõrõlmasõ yapõlmaktadõr. Bir ofis binasõndaki tümüyle kompozit bir döşeme ele 
alõnmõştõr. Bu model AISC-ASD89 �un 9. baskõsõndaki Örnek 16 �dõr. Model tek katlõ, ölü ve 
hareketli yüklere maruz 3 boyutlu bir çelik çerçeve yapõsõdõr. 

  

Şekil 6-4  Yapõnõn 3D Görünüşü 

Bilgisayar Modeli Tanõmõ 

Tek katlõ yapõ 36 feet uzunluğundadõr ve kirişleri arasõndaki mesafe 8 feet �dir. Kip-inç-saniye 
birimleri kullanõlmaktadõr. Elastisite modülü 29000 ksi �dir. Çerçevenin geometrisini görmek 
için Şekil 6-4 �e bakõnõz.  

Yapõyla ilgili diğer parametreler aşağõdaki gibidir:  

Beton ağõrlõğõ = 145 pcf 
Poisson oranõ = 0.3 
Minimum Akma Gerilmesi, Fy = 36 ksi  
Minimum Çekme Dayanõmõ, Fu = 65 ksi 
Beton Basõnç Dayanõmõ, f�c  = 3 ksi 

Kompozit Döşeme Özellikleri: 

Döşeme Kalõnlõğõ = 2 in 
Kompozit Döşeme Kalõnlõğõ = 2 in  
Diş (rib) Genişliği = 2.5 in 
Diş (rib) Aralõğõ = 6 in 
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Saplama (stud) çapõ = .75 in 
Saplama (stud) yüksekliği = 3.5 in 

Binaya gelen Yükler: 

Hareketli Yük = 100 psf 
Bölme Duvar Yükü    = 20 psf 
Tavan Kaplamasõ Yükü = 8 psf 

Sonuçlar 

Analiz ve kompozit kiriş boyutlandõrma çalõştõrõldõktan sonra, bir kiriş elemanõnõn üzerine sağ 
tuşla tõklayarak Interactive Composite Beam Design (Etkileşimli Kompozit Kiriş 
Boyutlandõrmasõ) formunu görüntüleyiniz. Kiriş boyutlandõrmasõnõn bir özetini görmek için 
Details (Detaylar) kutusuna tõklayõnõz. AISC-ASD örneğinde 30 adet kesme saplamasõ (shear 
stud) olan W21x44 boyutunda kirişler hesaplanmõştõ. Şekil 6-5 �de ETABS tarafõndan aynõ 
W21x44 kiriş boyutunun ve 31 adet kesme saplamasõ (shear stud) gerektiğinin hesaplandõğõnõ 
görebilirsiniz. Bunu görüntülemek için Design > Composite Beam Design > Display Design 
Info (Boyutlandõrma > Kompozit Kiriş Boyutlandõrma > Boyutlandõrma Bilgilerini Göster)  
formunda Beam Sections (Kiriş Kesitleri) ve Shear Stud Layout (Kesme saplamasõ 
Yerleşimi) seçeneğini seçiniz.  

 

 

Şekil 6-5  Kõsmi Plan � Kompozit Kiriş Boyutlandõrma Sonuçlarõ 
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Örnek VII Nonlineer Zaman Alanõ Analizi  
(Nonlinear Time History Analysis) 

Tanõm 

Bu örnek üzerinde link elemanlarõ olan 3 basit 2D çerçeveden oluşmaktadõr. Nonlineer zaman 
alanõ analizi yapõlmaktadõr. İlk çerçevede link elemanõ yoktur. İkinci çerçeve yatay yüklere 
karşõ koyan sönümleyici (damper) link elemanlarõ içermektedir. Üçüncü çerçevede ise sismik 
izolatör (isolator) link elemanlarõ vardõr. Çerçevelerin geometrisi Şekil 7-1 �de görülmektedir.  

Örnekte Gösterilen Önemli ETABS seçenekleri 

! Zaman Alanõ Fonksiyonu (Time History Function) Tanõmõ 

! Zaman Alanõ Analiz Durumu (Time History Case) Tanõmõ 

! Sönümleyici / Sismik İzolatör Link Özellikleri (Damper/Isolator Link Properties) 
! .AVI Dosyasõ Oluşturma 

! Zaman Alanõ İzleri (Time History Traces)  
! Davranõş Spektrumu Eğrileri (Reponse Spectrum Curves) 

Bilgisayar Modeli Tanõmõ 

Çerçeveler tek açõklõklõdõr ve açõklõklarõ 24 feet �dir. Tüm çerçeveler 3 katlõdõr. Kat 
yükseklikleri 12 feet �dir. Kip-inç-saniye birimleri kullanõlmaktadõr. Elastisite modülü 29000 
ksi �dir. Tüm düğüm noktalarõna X ve Y doğrultularõna .25 kip-sn2/in �lik noktasal kütle 
atanmõştõr.  

Link Elemanõ Tanõmõ 

Sönümleyici ve İzolatör Link Elemanõ 

Define menüsü > Link Properties (Tanõmla > Link Özellikleri) komutuna tõklayarak 
Define Link Properties (Link Özellikleri Tanõmla) formunu görüntüleyiniz. Add 
New Property (Yeni Özellik Ekle) kutusuna tõklayarak NLLink Propery Data 
(NLLink Özellik Bilgisi) formunu görüntüleyiniz. Aşağõ açõlõr menüden Damper 
(Sönümleyici) veya Isolator (İzolatör) link elemanlarõndan birini seçiniz. Kütle 
(mass), Ağõrlõk (weight) ve Polar Atalet Momenti (rotational inertia) için istediğiniz 
değerleri giriniz. Kütlenin elemanõn tüm boyu için olduğuna ve birim hacim kütlesi 
olmadõğõna dikkat ediniz. Genel olarak, Link elemanlarõna iki çeşit özellik atanõr.  
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• Lineer Özellikler (Linear Properties) sadece lineer link elemanlarõna 
atanabilirler. Bir lineer link elemanõnõn altõ serbestlik derecesinin tamamõ için 
belirlenen lineer özellikler etkin rijitliği oluşturur. Bu esasõnda bir yay 
rijitliğidir. 

• Nonlineer Dinamik Özellikler (Nonlinear Dynamic Properties)  nonlineer 
dinamik (zaman alanõ) analizinde kullanõlõrlar. Nonlineer dinamik link 
özelliklerini kullanabilmek için ETABS �õn Nonlineer versiyonuna sahip 
olmanõz gerektiğine dikkat ediniz.  

 

Lineer link elemanlarõ haricindeki diğer tüm link elemanõ tiplerinde, altõ serbestlik derecesinin 
tümü için belirlenen lineer özellikler etkin rijitlik ve etkin sönümdür. Bu gibi durumlarda, 
etkin rijitlik yine bir yay rijitliğidir. Etkin sönüm dashpot-tipi (pistonlu amortisör)  sönüm ile 
tanõmlanõr; kritik sönüm oranõ ile tanõmlanmaz.  

Lineer analizde ETABS link elemanlarõ için tanõmlanan etkin sönümü modal sönüme çevirir. 
Daha sonra sonuç modal sönümü üretmek için, modelde etkin sönümü tanõmlanmõş olan tüm 
link elemanlarõ için hesaplanan modal sönümü yapõ için önceden belirlenen modal sönüme 
ekler.  ETABS bu sonuç model sönümünü yapõnõn yazõcõdan alõnan analiz çõktõlarõnda rapora 
ekler. Bu çõktõyõ almak için File menüsü > Print Tables > Analysis Output (Dosya > 
Tablolarõ Yazdõr > Analiz Çõktõlarõ) komutuna tõklayõnõz ve Building Modal Info (Yapõ Mod 
Bilgisi) kutusunu işaretleyiniz.  

Link Elemanlarõnõn Atanmasõ 

 Sönümleyici Link Elemanõ (Damper) 

Draw > Draw Line Object > Draw Line (Çiz > Çizgi Nesnesi Çiz > Çubuk Çiz) 
komutuna gidiniz ve açõlan Properties of Object (Nesne Özellikleri) formunda 
Property (Özellik) kutusunda NONE seçeneğini seçiniz. Ortadaki çerçevenin tüm 
katlarõnda diyagonal çubuklar çiziniz. Çizdiğiniz bu çubuklarõ seçin, Assign > 
Frame/Line > Link Property (Ata > Çubuk/Çizgisel > Link Özelliği) komutuna 
gidin ve az önce tanõmladõğõnõz sönümleyici özelliğini seçiniz.  

 İzolatör Link Elemanõ (Isolator)  

Üçüncü çerçevenin en altõndaki düğüm noktalarõnõ seçiniz, Assign > Joint/Point > 
Restraints (Ata > Düğüm Noktasõ/Noktasal > Uç Serbestlikleri) komutuna gidiniz ve 
tüm doğrultulardaki serbestlikleri tutulu hale getiriniz. Yine aynõ düğüm noktalarõnõ 
seçip Assign > Joint/Point > Link Properties (Ata > Düğüm Noktasõ/Noktasal > 
Link Özellikleri) komutuna gidiniz. Az önce tanõmladõğõnõz izolatör özelliğini seçiniz.  

Modeliniz Şekil 7-1 �deki gibi görünmelidir: 
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Şekil 7-1  Üç Çerçeveli Zaman Alanõ Analizi 

Zaman Alanõ Fonksiyonu ve Analiz Durumunun Tanõmõ 

Biz bu örnekte, metin dosyasõ ile önceden verilmiş bir zaman alanõ fonksiyonunu 
tanõmlamakla ilgiliyiz. Define > Time History Function > Add Function from File 
(Tanõmla > Zaman Alanõ Fonksiyonu > Dosyada Fonksiyon Ekle) formuna gidiniz. Browse 
(Gözat) kutusuna tõklayõn ve zaman alanõ dosyasõnõ seçin. Burada Display Graph (Grafiği 
Göster) kutusuna tõklayarak zaman alanõ grafiğini görüntüleyebilirsiniz. Fonksiyon dosyasõ 
bilgilerini aşağõdaki gibi doldurunuz:  

 

Şekil 7-2  Zaman Alanõ Fonksiyonu Tanõmõ 
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Daha sonra, zaman alanõ analiz durumu (time history case) bilgisini tanõmlayacağõz. Define > 
Time History Cases > Add New History (Tanõmla > Zaman Alanõ Analiz Durumlarõ > Yeni 
Z.Alanõ Ekle) formuna gidiniz. Burada Analiz Tipini (Analysis Type), Çõktõ Zaman Adõm 
Sayõsõ (Number of Output Time Steps) ve Çõktõ Zaman Adõm Boyutlarõnõ (Output Time Step 
Size) da içeren pek çok seçenek vardõr. Çõktõ zaman adõm boyutu (output time step size) eşit 
aralõklarla bölünmüş çõktõ zaman adõmlarõnõn arasõnda geçen zamanõn saniye cinsinden 
değeridir. Bunu zaman alanõ fonksiyonundaki zaman adõm boyutuyla karõştõrmayõnõz. Çõktõ 
zaman adõm boyutunun değeri zaman alanõ fonksiyonunda girilen zaman adõm boyutundan 
farklõ olabilir. Çõktõ zaman adõm sayõsõnõn (number of output time steps) çõktõ zaman adõm 
boyutuyla (output time step size) çarpõmõ sonuçlarõn çõktõlarõnõn raporlanacağõ toplam süreye 
eşittir.  

Zaman alanõ ivmemiz X-doğrultusunda olacaktõr. Rapor süresinin 12 saniye olmasõ 
istenmektedir, bu nedenle zaman adõmõ sayõsõnõ 6000 ve zaman adõmõ boyutunu da .002 
saniye olarak gireceğiz.  

Sonuçlar 

.AVI Video Dosyalarõnõn Üretilmesi 

Analiz çalõştõrõldõktan sonra (Analyze > Run Analysis menüsünden), ETABS bir .AVI 
animasyon dosyasõ oluşturabilir. File menüsü > Create Video > Time History Animation 
(Dosya > Video Üret > Zaman Alanõnda Animasyon)  komutunu kullanarak ETABS �da 
yapõnõn herhangi bir zaman alanõ analizindeki hareketini gösteren videosunu üretebilirsiniz. 
Video dosyasõ için aşağõdaki verileri giriniz:  

Bir video dosyasõ üretilebilmesi için Start Time (Başlangõç Zamanõ), End Time (Bitiş 
Zamanõ) ve Time Increment (Zaman Artõmõ) değerlerinin girilmesi gereklidir. Bitiş 
zamanlarõ ve zaman artõmõ değerlerini kendiniz tanõmlayabilir ya da ön tanõmlõ değerleri 
kullanabilirsiniz. Zaman artõmõ (time incremet) değeri yapõnõn şekil değiştirmiş durumundan 
saniyede kaç adet farklõ resim üretileceğini kontrol eder.  Örneğin, zaman artõmõnõn 0.1 olmasõ 
zaman alanõnda her saniyenin onda biri süresinde şekil değiştirmiş halin bir resiminin 
üretilmesi anlamõna gelir.  

Zaman Alanõ İzleri (Time History Traces) 

Zaman alanõ analizi çalõştõrõldõktan sonra, Display menüsü  > Show Time History Traces 
(Görüntüle > Zaman Alanõ İzlerini Göster) komutuna tõklayarak Time History Display 
Definition (Zaman Alanõ Görünüş Tanõmõ) formunu görüntüleyiniz. Gereken bilgileri 
sağlayarak bu formda çeşitli zaman alanõ eğrileri çizebilirsiniz.  

Zaman alanõ izi (time history trace) basitçe düşey zaman alanõ fonksiyonunun yatay zaman 
alanõ fonksiyonuna göre grafiğidir. Düşey zaman alanõ fonksiyonu tanõmlanan herhangi bir 
zaman alanõ fonksiyonu olabilir. Yatay zaman alanõ fonksiyonu ön tanõmlõ olarak Zaman 
(Time) olmasõna rağmen tanõmlanan diğer herhangi bir zaman alanõ fonksiyonu da olabilir.  

Display menüsü > Show Time History Traces (Görüntüle > Zaman Alanõ İzlerini Göster) 
komutuna tõklandõğõnda ETABS otomatik olarak tüm seçili nesneler için zaman alanõ gösterim 
fonksiyonlarõnõ üretir. Gerektiğinde Time History Display Definition (Zaman Alanõ Görünüş 
Tanõmõ) formunu kullanarak ek zaman alanõ gösterim fonksiyonlarõ da tanõmlanabilir. Örneğin 
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belirli bir noktanõn zaman alanõ izini göstermek için, en kolayõ o noktayõ Display menüsü > 
Show Time History Traces (Görüntüle > Zaman Alanõ İzlerini Göster) komutunu 
kullanmadan önce seçili duruma getirmektir. ETABS o nokta için zaman alanõ gösterim 
fonksiyonlarõnõ otomatik olarak üretecektir. Eğer ETABS ön tanõmlõ olarak sizin istediğiniz 
deplasmanõ göstermediyse bunu kolayca değiştirmeniz mümkündür. 

Biz bu örnekte  2,4 ve 6 numaralõ düğüm noktalarõnõn deplasman değerleriyle ilgileniyoruz.  
Bu düğüm noktalarõnõ Time History Traces (Zaman Alanõ İzleri) iletişim kutusundaki 
Vertical Functions (Düşey Fonksiyonlar) fonksiyon kolonuna ekleyiniz. Define Functions 
(Fonksiyon Tanõmla) kutusuna tõklayõnõz, 2 nolu düğüm noktasõnõ seçiniz ve Modify/Show 
TH Function (ZA Fonksiyonu Düzenle Ekle) kutusuna tõklayõnõz. Vector Type (Vektör Tipi)  
alanõnda Displacement (Yer Değiştirme)  seçeneğinin seçili olduğuna emin olunuz. Bu işlemi 
4. ve 6. düğüm noktalarõ için tekrarlayõnõz. Artõk zaman alanõ izlerini görmek için hazõrõz. 
Şekil 7-3 �e bakõnõz.  

 

Şekil 7-3  Zaman Alanõ İzi Grafiği 

Şekilden en büyük deplasmanõ 2 nolu düğüm noktasõnõn yaptõğõnõ görebilirsiniz, bunu 6 nolu 
düğüm noktasõ (izalatörlü çerçeve sistemi) ve 4 nolu düğüm noktasõ (sönümleyicili çerçeve 
sistemi) izlemektedir.  

Davranõş Spektrumu Eğrileri (Response Spectrum Curves)  

Zaman alanõ analizi çalõştõrõldõktan sonra, bir veya daha fazla sayõda düğüm noktasõ seçip 
Display menüsü > Show Response Spectrum Curves (Görüntüle > Davranõş Spektrumu 
Eğrilerini Göster) komutuna tõklayarak Response Spectrum Generation (Davranõş 
Spektrumu Üretimi) formunu görüntüleyiniz. Davranõş spektrumu grafiklerini çizdirmek için 
bu formu kullanarak gerekli bilgileri giriniz. 
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Önemli Not: Bu komutu kullanarak çizdirdiğiniz davranõş spektrumu çalõştõrõlan zaman alanõ 
analizine dayanõr. Daha önceden çalõştõrõlmõş herhangi bir davranõş spekturumu analiziyle 
ilişkisi yoktur.  

Davranõş Spektrum Eğrileri gösterilirken çeşitli seçenekler mevcuttur. Bunlar Eksenleri 
(Axes) , Sönümü (Damping) ve Periyot/Frekans (Period/Frequency) tanõmlarõnõ içerir. Bir 
davranõş spektrumu eğrisi örneği Şekil 7-4 �de görülmektedir.  

 

Şekil 7-4  Davranõş Spekturum Eğrisi Grafiği 

 



www.comp-engineering.com/havuz.html  Computers & Engineering 

ETABS ile Çelik Yapõlarõn Optimize Edilerek Modellenmesi ve Boyutlandõrõlmasõ   49 

 

Örnek VIII Statik İtme Analizi  
(Pushover Analysis) 

Tanõm 

Bu örnek nonlineer statik itme analizine karşõ koyan dört katlõ bir düzlem çerçeve yapõsõdõr. 
Tüm katlar 12 feet yüksekliğinde, tüm açõklõklar 24 feet uzunluğundadõr. Tüm çubuk 
elemanlara nonlineer çubuk mafsallarõ (nonlinear frame hinges) atanmõştõr. Çerçevenin 
geometrisi Şekil 8-1 �de gösterilmektedir.  

Örnekte Gösterilen Önemli ETABS Seçenekleri 

! Statik Çubuk Mafsalõ (Static Frame Hinge) Tanõmõ 

! Statik Nonlineer İtme Analiz Durumu (Static Nonlinear Pushover Case) Tanõmõ 

! İtme Analizi Eğrileri (Pushover Curves)  
 

 

Şekil 8-1  Statik itme analizi yapõlacak yapõnõn 3D görünüşü 
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Bilgisayar Modeli Tanõmõ 

Nonlineer statik analiz (pushover analizi dahil) özelliği sadece ETABS �õn nonlineer 
versiyonunda bulunmaktadõr. Bu özellik, performansa dayalõ sismik tasarõm için statik itme 
(pushover) analizi yapõlmasõna olanak tanõr. Buna ek olarak genel nonlineer statik analiz 
(static nonlinear analysis) ve aşamalõ inşaat analizi (staged consturuction) yapõlmasõ için de 
kullanõlõr. Nonlineer analiz yapmak zaman ve sabõr isteyen bir işlemdir.  

Mafsal Özelliği Tanõmõ 

Define menüsü > Frame Nonlinear Hinge Properties (Tanõmla > Çubuk Nonlineer Mafsalõ 
Özellikleri) komutunu seçerek Define Frame Hinge Properties (Çubuk Mafsal Özellikleri 
Tanõmla) formunu görüntüleyiniz. Frame Nonlinear Hinge Properties,  çubuk (çizgisel) 
elemanlar üzerine atanabilen nonlineer kuvvet-deplasman veya moment-dönme ilişkilerini 
tanõmlamak için kullanõlõrlar.  Nonlineer mafsallar sadece statik nonlineer (pushover) analizde 
kullanõlõrlar. Diğer analiz tipleri için bu mafsallarõn rijit olduklarõ kabul edilir ve elemanlarõn 
lineer davranõşõ üzerinde etkileri olmaz.  

Çelik elemanlar için ön tanõmlõ mafsal özellikleri genel olarak FEMA-273 �ün 5.4 ve 5.8 
tablolarõna dayanõr. Betonarme elemanlar için ön tanõmlõ mafsal özellikleri ise genel 
olarak ATC-40 �õn 9.6, 9.7 ve 9.12 tablolarõna dayanõr.  Ön tanõmlõ mafsal özelliklerini 
kullanmadan önce bunlarõn sizin projeniz için uygun olup olmadõğõnõ kontrol ediniz.  

Ön tanõmlõ mafsal özellikleri değiştirilemez. Aynõ zamanda, ön tanõmlõ özellikler atandõklarõ 
elemanlarõn kesitlerine bağlõ olduklarõndan bir elemana atanmadõklarõ sürece gözden 
geçirilemezler. Program ön tanõmlõ özellikleri uygulanacaklarõ kesitler belirlenene kadar tam 
anlamõyla tanõmlayamaz. Bu nedenle ön tanõmlõ özelliklerin etkilerini göremek için, ön 
tanõmlõ özellik bir çubuk elemana atanmalõdõr; ancak bu yapõldõktan sonra üretilen mafsal 
özellikleri görülebilir.  

Bu model için mafsal özelliklerini kendimiz tanõmlayacağõz. Kullanõcõ-tanõmlõ mafsal 
özellikleri tamamen kullanõcõ tarafõndan üretilebildiği gibi ön tanõmlõ özelliklere dayalõ olarak 
da üretilebilir. Kullanõcõ-tanõmlõ özellikler ön tanõmlõ özelliklere dayandõrõldõğõ zaman, ön 
tanõmlõ özelliklerin kesite bağlõ olmasõndan dolayõ mafsal özellikleri görüntülenemez. 
Kullanõcõ-tanõmlõ özellikler ön tanõmlõ özelliklere dayandõrõlmazsa özelliklerin 
görüntülenmeleri veya değiştirilmeleri mümkündür.  

Mafsal Özelliği (Hinge Property) Atanmasõ 

Assign menüsü > Frame/Line > Frame Nonlinear Hinges (Ata > Çubuk/Çizgisel > Çubuk 
Nonlineer Mafsallarõ) komutunu seçerek Assign Frame Hinges (Pushover) (Çubuk 
Mafsallarõ Ata (İtme Analizi)) formunu görüntüleyiniz. Hinge Property (Mafsal Özelliği) 
kutusundan bir mafsal özelliği seçin. Relative Distance (Göreceli Uzaklõk) kutusuna bir 
mesafe giriniz (değerin 1 �den küçük olmasõ gerektiğine dikkat ediniz). Add (Ekle) kutusuna 
tõklayõnõz.  

Bir mafsal atamasõ, mafsal özelliği (hinge property) ve çubuk eleman üzerinde bulunan 
mafsalõn konumundan (relative distance) oluşur. Konum, elemanõn boyuna göre relatif 
uzaklõk ile tarif edilir ve elemanõn i-ucundan ölçülür. Relatif uzaklõk elemanõn  i-ucundan 
mafsala olan mesafenin çubuk elemanõn boyuna bölümüne eşittir. Mafsallar uç ofsetleri (end 
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offsets) içine konamazlar. Eğer belirlenen relatif uzaklõk mafsalõ bir uç ofset içine koyarsa, 
mafsal otomatik olarak o ofsetin iç yüzüne kaydõrõlõr.  

Statik Nonlineer İtme Analiz Durumu (Static Nonlinear Pushover Case) Tanõmõ   

Define menüsü > Statik/Nonlinear/Pushover Cases (Tanõmla > Statik Nonlineer/İtme 
Analiz Durumlarõ) komutunu seçerek Define Static Nonlinear Cases (Statik Nonlineer 
Analiz Durumu Tanõmla) formunu görüntüleyiniz. Statik nonlineer/itme analizi özelliği 
ETABS �õn sadece nonlineer versiyonunda bulunmaktadõr. Bu özellik, performansa dayalõ 
sismik tasarõm için statik itme (pushover) analizi yapõlmasõna olanak tanõr. Buna ek olarak 
genel nonlineer statik analizi (static nonlinear analysis) ve aşamalõ inşaat analizi (staged 
consturuction) yapõlmasõ için de kullanõlõr. Analizin çalõştõrõlmasõndan önce statik nonlineer 
yük durumu tanõmlanmalõdõr.  

İtme analizi durumlarõnõ tanõmlarken pek çok seçenek mevcuttur. Bu modelde genel olarak 
program tarafõndan sağlanan ön tanõmlõ değerleri kullanacağõz. Push to Displacement 
Magnitude (Bu Deplasmana Kadar İt) kutusuna 25 inç değerini gireceğiz. Deplasman 
kontrollü analiz yapmak için Push to Displacement Magnitude kutusunu işaretleyin. Yük 
kombinezonlarõ formun Load Pattern (Yük Şablonu) alanõnda tanõmlanõr ancak büyüklüğü 
artan deplasmanlarõ kontrol altõnda tutmak için gerekli olduğu kadar artar ya da azalõr. Bu 
seçenek yanal yüklerin yapõya uygulanmasõnda, uygulanan yükün büyüklüğünün önceden 
bilinmediği durumlarda,  ya da yapõnõn dayanõmõnõn azalmasõnõn veya sabilitesini 
kaybetmesinin beklendiği durumlarda yararlõdõr. Eğer bu formdaki bölümler hakkõnda daha 
detaylõ bilgi almak isterseniz ETABS �õn Help (Yardõm) bölümüne gidin ve Static Nonlinear 
Case Data  altõna bakõnõz.  

Sonuçlar 

İtme Analizi Eğrileri (Pushover Curves)  

Nonlineer statik analiz çalõştõrõldõktan sonra, Display menüsü > Show Static Pushover 
Curve (Görüntüle > Statik İtme Eğrisini Göster) komutuna tõklayarak Pushover Curve (İtme 
Eğrisi) formunu görüntüleyiniz. Statik itme eğrisi (static pushover curve) nonlineer statik 
analizinden elde edilen tek bir kuvvet-deplasman eğirisidir. Pushover eğrisini Acceleration-
Displacement Response Specturum (ADRS) düzeninde görüntüleyiniz ve üzerine çeşitli 
davranõş specturumlarõnõ (response spectra) üzerine koyunuz; böylece ETABS �da kapasite-
spekturum analizi yapabilirsiniz.  

Örneğimizde, yapõnõn şekil değiştirmiş halini Display menüsü > Show Deformed Shape 
(Görüntüle > Şekil Değiştirmiş Hali Göster) altõndan itme analizi (pushover) durumunu 
seçiniz ve 1. Adõma (Step 1)  gidiniz. Ekranõn sağ alt kenarõndaki ok tuşlarõnõ kullanarak adõm 
adõm çerçevedeki mafsallaşmalarõ görebilirsiniz. Mafsallarõn üzerindeki noktalarõn renkleri 
her adõmda değişmektedir. Örneğin, mavi nokta yapõnõn kullanõlabileceğini (immediate 
occupancy state) aşamasõna ulaştõğõnõ gösterir, yeşil nokta yapõnõn kullanõlamayacağõnõ fakat 
çökmeyeceğini (collapse prevention) �õ gösterir, kõrmõzõ nokta ise yapõdaki göçmeyi (failure) 
gösterir. Şekil 8-2 ve 8-3 �e bakõnõz. 
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Şekil 8-2  Yapõnõn şekil değiştirmiş hali 

Şekil 8-2 �de en alt kattaki kolonlarõn I ve J uçlarõnda kõrmõzõ noktalar görülmektedir. Bu 
durum o kolonlarõn kapasitesine ulaştõklarõnõ ve yapõnõn yõkõldõğõnõ gösterir. En üstteki 
deplasman 23.32 inç �tir. Şekil 8-3 �deki itme eğrisi (pushover curve)  bu deplasmanda 
yapõnõn yõkõldõğõnõ göstermektedir.  
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Şekil 8-3  İtme Eğrisi 

 

 

 


